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Setting Up an AP Checkbook
1. Select Microsoft Dynamics GP  Tools  Setup  Purchasing  Mekorma
MICR  Checkbook Setup.
2. On the Mekorma MICR Checkbook Setup window, enter a Checkbook ID.
3. Enter the MICR line characters in the MICR Line Setup boxes. Use an existing
check along with a MICR Gauge to find the proper position for each character.
There are several special characters:
A

Transit Number symbol

B

Dash

C

On-Us Symbol

D

Amount Symbol

X

Check Number
Placeholder. The number
of X’s should match the
number of digits in your
check number.

4. In the Transit (ABA) Routing Number field, enter the Fractional Routing number
from the upper right of the check. Use ‘/’ to replace a horizontal line.
5. Select an .stbz file using the look-up for the Primary Check Format* field.
6. Click the words “Primary Check Format” to open the Mekorma Configurator.
Make any desired edits to the your check and remittance stub format.
The Mekorma Configurator is a specialized graphical layout tool for checks and
remittance stubs, but it uses many standard page layout tools.
a. Use the mouse to select fields to move, re-size or delete. You can
use the control key to select multiple fields.
b. Use the Zoom In and Zoom Out buttons to see more of the page or
get a closer look at a field.
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c. To add fields, labels, lines and images, use the Add Elements
button. The element will be added to the upper left corner of the
format. It can then be moved to the check or stub of your choice.
d. Select entire regions to move or delete the region and all fields. A
region will appear as blue when selected. To de-select a region,
click on white space or any unselected element.
e. For finer manipulation, to change font, for alignment and other
adjustments, select a field and use the Properties box in the lower
left of the Configurator window.
f. You can select and copy entire regions to make duplicate
remittance stubs.
g. For quicker alignment of fields, use the Alignment tools on the
Layout tab at the top of the Configurator window.
h. You can use the Save and Test function on the Home tab for a
quick preview of the layout with demo data.

5. (optional) If you will print physical check copies of all checks each time you
print, choose a check copy format. If not, you can leave this blank.
6. (optional) Mark the ‘Use Check Format (First page) for overflow pages’ box if
you want excess remittance information to flow to the next piece of check
stock in the printer.
7. (optional) If you would like to use a separate format for excess remittance
information, choose select a format in the Check Overflow Format field. This
format can be printed on different paper from a separate tray in the same
printer but will still be properly collated with the checks.
8. (optional) In the Non-Negotiable Word field enter a word to print as a
watermark on check copies.
9. (optional) Choose an EFT Remittance option. You can use the Microsoft
Dynamics GP Separate Remittance report, your Mekorma MICR check format
or a different Mekorma MICR format you create specifically for EFTs.
10. (optional) If you will be using the Refund Checks feature in Microsoft
Dynamics GP along with Mekorma MICR enter a Refund Check format.
Otherwise, you can leave these fields blank.
11. Choose Save.
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Setting Up an US Payroll Checkbook
1. Select Microsoft Dynamics GP  Tools  Setup  Payroll  Mekorma
MICR  Check Setup.
2. On the Mekorma MICR Checkbook Setup window, enter a Checkbook ID.
3. Enter the MICR line characters in the MICR Line Setup boxes. Use an
existing check along with a MICR Gauge to find the proper position for each
character. There are several special characters:
A

Transit Number symbol

B

Dash

C

On-Us Symbol

D

Amount Symbol

X

Check Number Placeholder. The
number of X’s should match the
number of digits in your check
number.

4. In the Transit (ABA) Routing Number field, enter the Fractional Routing
number from the upper right of the check. Use ‘/’ to replace a horizontal line.
5. Select an .stbz file using the look-up for the Primary Check Format field.
6. Click the words “Primary Check Format” to open the Mekorma Configurator.
Make any desired edits to your check and remittance stub format.
a. The Mekorma Configurator is a specialized graphical layout tool for
checks and remittance stubs, but it uses many standard page layout tools.
b. Use the mouse to select fields to move, re-size or delete. You can use the
control key to select multiple fields.
c. Use the Zoom In and Zoom Out buttons to see more of the page or get a
closer look at a field.
d. To add fields, labels, lines and images, use the Add Elements button. The
element will be added to the upper left corner of the format. It can then be
moved to the check or stub of your choice.
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e. Select entire regions to move or delete the region and all fields. A region
will appear as blue when selected. To de-select a region, click on white
space or any unselected element.
f. For finer manipulation, to change font, for alignment and other
adjustments, select a field and use the Properties box in the lower left of
the Configurator window.
g. You can select and copy entire regions to make duplicate remittance
stubs.
h. For quicker alignment of fields, use the Alignment tools on the Layout tab
at the top of the Configurator window.
i.

You can use the Save and Test function on the Home tab for a quick
preview of the layout with demo data.

7. (optional) If you will print physical check copies of all checks each time you
print, choose a Check Copy format. If not, you can leave this blank.
8. (optional) In the Non-Negotiable Word field enter a word to print as a
watermark on check copies.
9. Choose Save.

Using Mekorma MICR with Pre-Printed Check Stock
To print separate remittances using the Dynamics GP Report Writer, check the
Use Pre-Printed Check Stock option on the Mekorma MICR Setup (Payables)
screen.
When you check this option, the option under the Check Face field changes from
Use Check Format (First page) for overflow pages to Print separate
remittance for overflows. Check this option to print separate remittances using
the Dynamics GP Report Writer.
If checked, the Overflow Page Format field is automatically disabled and
separate remittances are used for overflows.

NOTE
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If the Use Pre-Printed Check Stock option is checked, when you print a check
containing more than 12 invoices, the separate remittance prints automatically.

Testing the Check Layout and
Security
1. Select Microsoft Dynamics GP  Tools  Setup  Purchasing 
Mekorma MICR  Test Layout and Security to open the Mekorma MICR
Check Layout screen.
2. Select a Check Type from the drop-down list. The choices are Payables, US
Payroll or Canadian Payroll.
3. Use the lookup on the Checkbook ID field to select a checkbook you have
set up for Mekorma MICR.
4. In the Check Amount field, enter the amount to print in the currency fields on
the check. You can enter different amounts to test your password and
signature logic.
5. In the Number of Vouchers field, enter the number of remittance lines to
print on the stub. For example, if you want to see a stub that is paying five
invoices, enter “5”. If you are using an overflow format, enter a number large
enough to force the stub information to overflow to the next page.
6. Click Print. If you required User IDs and/or Passwords for the checkbook and
check amount, you see the Check Password screen.
7. Enter the User ID and Password and click OK.
8. If the applicable approver(s) has access to the checkbook, is authorized for
the check amount, and the correct password is entered, you see the
Mekorma MICR Check Printing screen.
9. On the Mekorma MICR Check Printing screen, confirm that the Check
Printer is the printer you will be using for checks. If not, select the check
printer from the drop-down list of printers.
10. Click Print to send the check to the printer and review the check layout.
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Setting Approvals and Signatures
Based on User ID
Importing Signature Images
Before it can be used, each signature image file must be imported into the
Signature Library.
1. Choose Import on the Mekorma MICR Signature Library window: Tools >
Company > Mekorma MICR > Signature Library.
2. Browse to select the signature image file you wish to use on your checks.
3. Repeat steps 1 – 2 in each company for each image to be used in that
company.

Assigning a Signature to a User ID
1. Open the Mekorma MICR Security Setup window: Tools > Setup >
Company > Mekorma MICR > Security Setup.
2. Use the Add/Modify User button to a Dynamics GP user that will sign
checks.
3. On the User Signature Entry window, enter the User ID.
4. Use the look-up to select a Signature Image ID from the Signature Library
and save the record.
5. Repeat for each user that will sign checks in that company.

Setting Rules for When Signatures Print
1. Open the Mekorma MICR Security Setup window: Tools > Setup >
Company > Mekorma MICR > Security Setup.
2. If you print a different number of signatures based on payment amount,
use the Password / Signature Threshold fields to enter the amount
threshold where the rules change for each module
3. Choose an option for the When to Print Signatures drop-down and save.
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Granting Payment Approval Authority to Users
1. Open the Mekorma MICR Security Setup window: Tools > Setup >
Company > Mekorma MICR > Security Setup.
2. Use the Add/Modify User button to open the User Signature Entry window.
3. Select the User ID that will approve payments.
4. In the Max. Amount Field choose unlimited or enter an upper limit for
which the selected User has approval authority and Save.
5. On the Mekorma MICR Security Setup window, select the User ID in the
scrolling window.
6. With the User ID selected, mark all the Checkbooks for which the User
has approval authority.

Setting Rules for Requiring Approval Before Printing
1. Open the Mekorma MICR Security Setup window: Tools > Setup >
Company > Mekorma MICR > Security Setup.
2. If you require a different number of approvers based on payment amount,
use the Password / Signature Threshold fields to enter the amount
threshold where the rules change for each module.
3. Select a rule from the When to Require Passwords drop-down.

Activating Secure Approval Workflow
1. Open the Mekorma MICR Security Setup window: Tools > Setup >
Company > Mekorma MICR > Security Setup.
2. Mark the Activate Workflow checkbox.
3. If you are using thresholds, mark the Split Batches box to automatically
split payments batches into groups by number of approvers and
signatures.

Enabling Approvals for EFT and Direct Deposit
1. Open the Mekorma MICR Security Setup window: Tools > Setup >
Company > Mekorma MICR > Security Setup.
2. Mark the EFT Security (Payables) and/or the DD Security (Payroll)
checkbox.
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Setting Separate Approval and Signature Rules Based
on Vendor Class
1. Open the Vendor Class Security window: Tools > Company > Mekorma
MICR > Vendor Class Security.
2. From the drop-downs list, select a new Approval rule and a new Signature
rule for each Vendor Class that should have rules separate from the rules
for the company configured on the Mekorma MICR Security window.
3. Save.

Using Signatures and Signature Lines with ‘No Security’
If you select the No Security option, you can still print signatures on your checks
as logos, using the Mekorma Configurator. If you want all the checks to be autosigned, but do not want to enter a password, you can add an image file of the
signature using the Add Picture function to the check stub (.stbx) file.
You could also scan a line under the signature so it prints on the check. If you do
not want the signature or passwords, but you want a line to print, you can add the
line (or lines) to the check format using the Configurator.
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Assigning Checkbooks for Invoice
Selection
Assigning an Invoice or Purchase Order to a Checkbook
You can assign Payables invoices, POP Shipment/Invoices and POP invoices to
checkbooks using the Mekorma Select by Checkbook option available from the
Additional menu on transaction entry screens.
The Additional menu options are available when an appropriate document entry
window is open. The Mekorma Select by Checkbook easyAdd Entry screen can
also be accessed from the Additional menu when a payables document inquiry
window is open. This allows users to edit checkbooks for posted, but unpaid
invoices.

 IMPORTANT
Credit Memos and Returns cannot be assigned to checkbooks.
Credits and Returns must be applied to the appropriate invoices to
be credited to the specified checking account.
To assign an invoice or PO to a checkbook:
1. Open a Payables invoice, POP Shipment, or POP invoice in an entry or
inquiry screen (for example, Transactions  Purchasing  Transaction
Entry).
2. On the Payables Transaction Entry screen, enter or select a Vendor ID,
then select Additional  Mekorma Select by Checkbook.
3. In the Mekorma Select by Checkbook easyAdd Entry screen, assign a
Checkbook ID and click OK.

NOTE
If you click Cancel or close the dialog box without clicking OK, the checkbook
may change based on Payables or invoice batch defaults.
4. Continue entering information in the entry or inquiry screen.

11

 IMPORTANT
You cannot assign checkbooks to Credit Memos or Returns. You
must manually apply Credit Memos and Returns to ensure they are
credited against the correct vouchers.

Assigning a Batch of Invoices to a Checkbook
If you want to assign a large group of invoices to a single checkbook, you can
save time by assigning them in a batch. First assign the checkbook on the
Payables Batch Entry screen, and then save each invoice to the batch. You can
still assign a different checkbook to individual invoices in the batch, if desired.
1. Select Transactions  Purchasing  Batches to open the Payables
Batch Entry screen. Select the desired Checkbook ID.
2. You can add invoices entered on the Payables Transaction Entry screen
to your batch. When all invoices have been saved to the batch, click the
Post button to post the batch.
3. Each invoice is assigned the checkbook that is assigned to the batch. The
only invoices in the batch not assigned to the checkbook are the invoices
which were assigned a different checkbook using the Select By
Checkbook easyAdd Entry screen.

Assigning Posted Invoices to a Checkbook
If you want to change the checkbook to which an invoice has been assigned after
the invoice has been posted, or you have invoices that were entered before the
Assign Checkbooks feature was installed, you can assign checkbooks using
either of the following inquiry screens:
 Inquiry  Purchasing  Transaction by Vendor
 Inquiry  Purchasing  Transaction by Document
To assign the checkbook:
1. Select the inquiry screen (for example Inquiry  Purchasing 
Transaction by Vendor) and highlight the invoice you wish to assign:
2. Select Additional  Mekorma Select by Checkbook option.
3. In the Mekorma Select by Checkbook EasyAdd Inquiry screen, select the
new Checkbook ID.
4. Click OK to close the dialog box.
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Assigning Vendors to Checkbooks
You can assign a Dynamics GP vendor to a specific checkbook. Assigning a
vendor to a checkbook allows you to automatically exclude that vendor from
check batches of other checkbooks.
The option to exclude vendors can be activated when each check batch is built.
Even if a vendor has been assigned to a checkbook, if the option to automatically
exclude is not selected at the time a check batch is built, the vouchers from the
vendor can be included in a check batch from any checkbook.
To assign a vendor to a checkbook:
1. Select Cards  Purchasing  Vendor. On the Vendor Maintenance
dialog box click Options and select a Checkbook ID.
2. Click OK to return to the Vendor Maintenance dialog box.

Selecting Invoices by Checkbook
After checkbooks have been assigned to vouchers and vendors, the next step is
to build your check batch using the Select Payables Checks dialog box. The
Assign Checkbooks feature cannot be used with the Edit Payables Checks
function.
To select invoices by checkbook:
1. Select Transactions  Purchasing  Select Checks. The Select by
Checkbook dialog box automatically opens with the Select Payables
Checks screen.
2. On the Select by Checkbook dialog box, check either the Select
vouchers by Voucher Checkbook ID or Select Vouchers by Vendor
Checkbook ID option.
3. Enter a Batch ID and any other applicable information on the Select
Payables Checks screen.
4. Click Build Batch to build the check batch.
5. Close the screen when finished.
Credit Memo Limitations
The following conditions apply to the Assign Checkbooks feature when working
with credit memos:
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 If you check the Select Voucher by Voucher Checkbook ID option, the
check will contain voucher information from the non-selected Checkbook
ID when credit memos and returns are involved. This does not occur for
vouchers that are invoice only.

 If the user has an applied credit memo or return in the system, the invoice
detail displays on the next check stub.
Using the Integration Manager
You can populate fields in the Mekorma Select by Checkbook Entry screen at the
time of integration using the Integration Manager. In the Integration Manager,
populate table ME27623 with the Voucher Number, Vendor ID, Checkbook ID,
and Address ID and enter a 1 in the ME_User_Chosen field.

NOTE
Please refer to Microsoft Dynamics GP User Guide for information on using the
Integration Manager feature.
Changing the VPS Hotkey in the Dex.ini File
The default hotkey to open the Assign Checkbooks feature from Dynamics GP
screens is CTRL+E. If desired, you can change the VPS hotkey in the dex.ini file.
To change the hotkey, enter VPS_HOTKEY=X in the Dex.ini file, where X is the
new hotkey letter, for example, VPS_HOTKEY=K.

Approving Checks / EFT with
Workflow
After building a batch of payments, the batch can be locked before printing.
Secure Approval Workflow can be used to notify approvers and facilitate
payment approvals. Workflow must already have been selected on the Mekorma
MICR Security Setup window.
1. After building a batch of payments, select the Request Approval button on
one of these windows:
a. Select Check (under Additional)
b. Edit Check Batch (under Additonal)
c. Edit Check (uder Additional)
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d. Print Payables Checks (replaces Print button)
An email or text message will be sent to all eligible approvers.
2. After receiving notification of payments pending approval, open the
Mekorma MICR Checks/ EFTs Pending Approval navigation list.
3. To review the payments in a batch, select the batch and choose Mekorma
Batch Drill-Down under Go To.
You will be able to see all transaction in the batch. You cannot add or
modify any payment, but you can review or reject.
To review the details of a transaction, select the associated payment on
the left then double-click the specific transaction on the right.
On the Mekorma Approval Batch Drill Down type in a reason for rejecting
the items or leave blank.
4. After reviewing and/or rejecting transactions in the batch, select OK on the
Mekorma Approval Batch Drill-Down window.
5. To approve payments, in the navigation list, mark the batch and choose
Approve.
6. When all needed approvals are obtained, a notice will be sent to the
Requestor to inform them the payments are ready to be printed.

Granting Access to Alternate Print
Windows
Mekorma MICR uses alternate MIcrosoft Dynamics GP windows for printing
payables transaction checks, payables batch checks and US payroll checks.
Security must be granted to these alternate windows for each user printing
checks.
1. Log on to GP as a system administrator and select Microsoft Dynamics GP
 Tools  Setup  System  Alternate/Modified Forms and Reports.
2. Select an Alternate/Modified Forms and Reports ID and enter the following
values in the fields:
Product: Mekorma MICR
Type: Windows
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3. In the Alternate /Modified Forms and Reports List, open the folders (by
clicking the + sign) and verify that Mekorma MICR is selected.
4. Repeat Step #3 for each user ID you wish to grant access to.

 IMPORTANT
You must grant access to the standard Dynamics GP window before
access can be granted to the alternate version of the window.
Alternate windows will not appear in the access list until security has
been granted

Printing a Payables Transaction
Check
The process for printing payables transaction checks with Mekorma MICR
follows the same steps as printing standard Dynamics GP payables transaction
checks with the exception of using the alternate Print Mekorma MICR Payables
Transaction Checks screen rather than the standard Dynamics GP Print
Payables Transaction Checks screen.
Dynamics GP security must be set to the Mekorma MICR alternate windows for
each user printing payables transaction checks in the company.

NOTE
When using Mekorma MICR to print payables checks, the Separate Remittance
option found on the Dynamics GP Payables print screen is not displayed
because we have the overflow stubs option which replaces that GP feature.
To print a payables transaction check:
1. Select Transactions  Purchasing  Transaction Entry. You see the
Payables Transaction Entry screen. Enter the applicable information.
2. When tab out of the Check Amount field, you see the Payables Check Entry
screen.
3. This is a standard Microsoft Dynamics GP screen. If desired, you can change
the selected Checkbook ID. Click OK to close this screen and proceed.
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4. After entering the transaction information, click Print Check on the Payables
Transaction Entry screen. You see the Print Mekorma MICR Transaction
Check screen.

NOTE
If you did not suppress warning messages, the Security Settings for Mekorma
MICR screen displays stating that you must setup security to the Mekorma MICR
alternate print check windows. If this message appears, click OK on the screen
and set security to the alternate windows.
5. Click Print. After entering any required User IDs and/or Passwords, the
Mekorma MICR Check Printing screen is displayed:

6. Click Print to print checks. If you want to print check copies, click the Use
Copy Printer option to display the check copy fields (see Printing Check
Copies for more information).

Printing Payables Batch Checks
The process for printing payables batch checks with Mekorma MICR follows the
same steps as printing standard Dynamics GP payables batch checks with the
exception of using the alternate Print Mekorma MICR Payables Checks screen
rather than the standard Dynamics GP Print Payables Checks screen.
Dynamics GP security must be set to the Mekorma MICR alternate windows for
each user printing payables batch checks in the company. See the Granting
Security Access to Alternate Windows section of this guide.

NOTE
You can use the Applied Order option of the List Document field on the Select
Payables Checks screen with any stub fields except for the GL Distribution fields.
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This option lists credit memos directly after the invoice they were applied to
instead of in the order the documents were entered.
Because the Applied Order option does not work with the GL distribution and
the multi-currency stub contains GL distribution fields, this option should not be
used with the Multi-currency stub file provided in the Mekorma Check Format
Library.
To print payables batch checks:
1. Build the check batch using regular Microsoft Dynamics GP procedures. Click
Print Checks on the Select Payables Checks screen to display the Print
Mekorma MICR Payables Checks screen.

NOTE
If you are using the Payables Workflow, the Print button is replaced with a
Request Approval button until the batch is approved.
2. Be sure the title of the window includes the words Mekorma MICR. If not, abort the
procedure and set up security to the Alternate Mekorma MICR Print Payables
Checks window.

NOTE
If you did not suppress warning message, the Security Settings for Mekorma
MICR screen displays stating that you must setup security the Mekorma MICR
alternate print check windows.
3. If desired, you can change the Check Number, Check Date and Check
Comment. The Check Comment for each check will print in the
Payment::Check Comment field.
4. Select a sort order using the Sort Checks By drop-down list options. Checks
will be sorted in the order specified in the drop-down list.
5. Click the Print icon to view the report options:
The Check Edit List report displays the standard Microsoft Dynamics GP
Check Edit List report.
The MICR Check Preview report displays the order the checks will print
after being resorted into threshold groups in addition to the payments being
made by Electronic Fund Transfer.

NOTE
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The checks are only re-sorted into threshold groups if the Sort Checks in
Threshold Groups when Printing option is marked on the Mekorma MICR
Password and Signature Setup screen for the Signature ID assigned to the
checkbook.
6. Click Print to proceed. After entering any required User IDs and/or
Passwords, you see the Mekorma MICR Check Printing screen.
7. Click Print to print checks.

Printing Multiple Check Batches at
One Time
This module provides an ability to automate the printing and posting of payables
batches across multiple companies. It works in conjunction with Mekorma MICR
to allow only approved batches for printing and posting. Instead of needing to log
in to each company separately, all batches can be viewed and selected for
processing from a single screen. Batches are further filtered out by the user’s
access level. This means users can only view and select batches from
companies of which they have access to.
Mekorma Multi-Batch Print & Post (referred to as MPP in this documentation)
automatically logs in to each company and completes the processing for the
check batches you select. At the end of the process, the system logs in to the
company you started in and displays the results.
MPP uses Dynamics GP’s macro system to process all batches. It builds and
runs a macro based on batches selected in the Multi-Batch Print and Post
screen. Because a macro will be running when you process your selection, you
must let the process run to completion before you resume working in Dynamics
GP.

NOTE
Multiple Batch Printing is not included in the basic Mekorma MICR license.
Multiple Batch Printing requires an additional license from Mekorma.
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Setting the Posting Journals to Print to File
To suppress the posting journal print dialog box, you must turn off the posting
journals. If posting journals are not turned off, MPP cannot process check
batches for that company.
•

Go to Microsoft Dynamics GP  Tools  Setup  Posting  Posting to
open the Posting Setup screen.

•

Choose the following options and click the Unmark All button to deselect reports:
Series:

Purchasing

Origin:

Computer Checks

If you want a file copy of a report, you can leave the Print box marked and check
only the File
Type checkbox for the report. Be sure the ,
and
boxes
are unmarked.
Printing Multiple Batches
Select Transactions  Purchasing  Multi-Batch Print and Post. You see
the Multi-Batch Print & Post screen.
Batches are displayed if they meet the following criteria and are based on the
View Batches and Show Batches With Error Status option selected.
•

If the window is set to print and batches are free of error and can be printed.

•

If the window is set to post and batches are free of error and can be posted.

•

The batch is approved and locked for editing.

• MEM (Multi-Entity Management) users must have access to the batch in the
MEM product.
By default, the Show Batches With Error Status option is checked to display a
status description for all batches, including any issues that prevent the batch
from being processed. If unchecked, only valid batches that are ready to print or
post are displayed.
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Select the applicable View Batches option:
Check
To Print to view only batches that are ready to print. If the checks/EFTs have
been already been printed for a batch, the batch it is not displayed.
To Post to view only batches that are ready to post. Only batches that have
successfully printed are displayed.

Select the applicable View Company option:
Check
All to view all the activated companies.
Current to view only batches for the company you are currently logged into.
Use the Print or Post column to mark the batches for printing and posting. If a
batch is not eligible for processing, clicking the checkbook generates an error
message.
Click the Print column drop-down arrow to select access the following menu:
Click
Mark All to mark all eligible batches for processing.
Unmark All to deselect all marked batches.
Reprinting
If the Print and Post failed as a result of a printer jam or power outage and you
need to reprint checks, use the standard Dynamics GP Post Payables Checks
screen to reprint the checks.

Posting Multiple Checks Batches
After printing the batches, click Procss to post the batches.
You see the macro screen indicating that the system is posting the check/EFT
batch.
You cannot use Dynamics GP during the posting or printing process to allow the
macros to run without interruption.
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Printing EFT Remittances
If you are printing EFT remittances, you can select the format for printing the
remittances by entering an option in the EFT Remittance Options field. The
selected format is displayed in the Mekorma MICR Check Printing screen when
you go to print the remittances.
You also can apply the same password security to your EFT Remittances that is
applied to your checks by checking the EFT Security option on the Mekorma
MICR Security screen. Before printing EFT remittances, verify that you have
completed the following processes:
 Enabled EFT in Dynamics GP
 Configured a Checkbook for EFT
 Set up pre-notes (if applicable)
 Configured a vendor for EFT (please see your Dynamics GP documentation
for more information)
To print EFT remittances after you have created an EFT batch:
1. Click the Process or the Print button on the Print Mekorma MICR Payables
Checks screen or select Transaction  Purchasing  Process
Remittance to display the Process Payables Remittance screen.
2. Verify that Remittance Form is selected click the Destination option you want
to use. Choose
Print Document to print the EFT Remittance.
Send Document in E-mail (Print if mail cannot be sent.) to send the
EFT Remittance in email. If this fails for any reason, the remittance will be
printed instead.

NOTE
The EFT Remittance option must be checked on the Mekorma MICR System
Options screen and Dynamics GP must be configured for email to email the EFT
remittance.
3. Click Process or Process Later.
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If you print EFT remittances using check numbers (zero dollar checks) and the
EFT Security option is checked on the Mekorma MICR Security screen, the
following is true:
 The program checks for passwords when you print checks from the Print
Mekorma MICR Payables screen. The number of passwords is determined
by your Mekorma MICR Security configuration.
 The program checks for passwords when you print the Remittance Form
but not when you Post the remittance.
If you print EFT remittances using EFT numbers, the following is true:
 If the EFT Remittance Options field on the Mekorma MICR Setup
(Payables) screen is set to “Dynamics GP Report Writer”, the program does
NOT check for passwords when you process EFTs from the Print Mekorma
MICR Payables screen (unless the EFT Security option is checked on the
Mekorma MICR Security screen, then the program does check for
passwords).
 If the EFT Remittance Options field on the Mekorma MICR Setup
(Payables) screen is set to “Check Face/Overflow Stub or EFT Remittance
Format”, the program does check for passwords when you process EFTs
from the Print Mekorma MICR Payables screen.

Printing US Payroll Checks
The first step is to create a US payroll batch using the standard Microsoft
Dynamics GP procedures. After you have built your checks and calculated them,
you are ready to print. To print US Payroll checks:
1. Select Transactions  Payroll  Print Checks to display the Print
Mekorma MICR US Payroll Checks screen.
2. Verify that the title of the screen includes the words Mekorma MICR. If not,
abort the procedure and set up security to the Alternate Mekorma MICR Print
Payables Checks window.
3. For Direct Deposit, select the Calculate Employee Deposits option for the
Process field.

NOTE
If you are printing Direct Deposit Earnings Statements “As Voided Checks”, they
will print interspersed with the checks using the Mekorma MICR format. If printing
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Direct Deposit Earnings Statements “Separate From Checks”, they will print after
the checks using the standard Microsoft Dynamics GP report.
4. Click Process to process the Direct Deposits. After calculating the Direct
Deposits or if you are not running Direct Deposits, from the Print Mekorma
MICR US Payroll Checks screen, select a sort order using the Sort Checks
By drop-down list.

 IMPORTANT
Checks will be numbered after being sorted in the order specified in
the drop-down list. However, if checks are being printed in threshold
groups, they will be grouped after being numbered so the checks will
not print sequentially by number. For this reason, threshold group
sorting cannot be used with pre-printed checks.
5. If desired, change the Starting Check Number and Check Date. To change
the Starting Check Number, the Override Check Number option on the
Checkbook Maintenance screen must be selected.
6. Verify the Print field is set to “Checks” and click Print to print the checks.

NOTE
If you would like a different sort order than the choices given, Mekorma can
create a custom sort order for you. Please contact us at 888-MEKORMA or click
here to visit our website and fill out a customization request.
7. Click Print to proceed. After entering any required User IDs and/or
Passwords, you see the Mekorma MICR Check Printing screen.
8. Define your print settings and click Print when you are ready to print
checks.

Reprinting Checks
When reprinting checks, the regular Microsoft Dynamics Post Checks screen is
used. You can reprint all the checks or a selected range of checks.
1. To reprint checks, on the Post Checks screen, set the Process field dropdown list to Reprint Checks.
2. Select a range for reprinting checks. Click the lookup icon on the From option
to display a list of checks.
3. Enter a check range and click Process to reprint the checks.
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Printing Canadian Payroll Checks
NOTE
The check numbering system for Canadian Payroll checks is configured on the
Payroll Control Setup – Canada screen, not the Checkbook Maintenance screen.
After completing the standard GP processes to generate and calculate Canadian
Payroll, complete the following steps to print Mekorma MICR checks:
1. Select Reports  Payroll – Canada  Transactions  Cheque Reports. You
see the Payroll Cheque Reports – Canada dialog box.

NOTE
To change the Cheque Number, the Override Cheque Number option on the
Checkbook Maintenance dialog box must be checked.
2. Verify that the Cheques radio button is selected and click Print Cheques.
3. Enter any required User IDs and/or Passwords are required.
4. On the Mekorma MICR Check Printing screen, confirm that the Check Printer is
the printer you want to use for checks. If not, select another printer from the dropdown list.
5. Click the Print to send the checks to the printer.
6. Click OK to proceed. The Mekorma MICR Check Printing screen is displayed
again with the Check Stub defaulting to the stub you entered in the Earnings
Statement field on the Mekorma MICR Setup (Payroll – Canada) screen.
7. Click Print to print Direct Deposits.

Printing Miscellaneous Checks
The Dynamics GP Miscellaneous Check feature allows you to print a check to
any entity without creating the entity as a vendor. Mekorma MICR uses the
Dynamics GP Miscellaneous Check screen, but intercepts the check printing
process and prints the checks using the Mekorma MICR check format assigned
to the checkbook.
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Unlike payables batch checks, payables transaction checks and payroll checks,
there is no alternate window for Miscellaneous Checks when using Mekorma
MICR and no security settings to configure. If Mekorma MICR is installed and
registered, Miscellaneous Checks print using Mekorma MICR.
If you do not want to use Mekorma MICR to print Miscellaneous Checks, you can
turn off this feature by checking the “Payables” box on the Mekorma MICR
Suppress Warnings screen.
To print a Miscellaneous Check:
1. Select Transactions  Financial  Miscellaneous Check. You see the
Miscellaneous Check screen.
2. When you are finished entering values in all required fields, click Print Check
and Post.
3. After entering any required User IDs and/or Passwords, you see the Mekorma
MICR Check Printing screen.
4. Click Print.

Printing Blank Checks
Blank checks are not posted to the General Ledger when they are printed. To
record them, they must be entered later as manual payments. Though the blank
checks are not recorded at the time of printing, if the default starting check
number is used, the Next Check Number field for the checkbook will be
advanced by the number of checks printed.
This can led to missing check numbers if one or more of the blank checks are
never entered as manual payments. To avoid this, change the starting check
number for the blank check batch. This prevents the Next Check Number from
advancing.
When printing blank checks, only one check approver is required, but the
approver must be assigned to the checkbook you are printing the blank checks
from (see Assigning Users to Checkbooks).

NOTE
When you first install Mekorma MICR, the Print Blank Checks menu option is
disabled until you enable it from the Mekorma MICR Security screen.
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To print blank checks:
1. Select Microsoft Dynamics GP  Tools  Setup  (Purchasing, US
Payroll or Payroll – Canada)  Print Blank Checks. You see the Print
Blank Checks screen for the applicable module.
2. Enter the Checkbook ID and the Number of Checks you would like to print.
If desired, enter a different Starting Check Number for the batch of blank
checks you plan on printing.
3. Select the number of Signature lines to print on each check. Signature lines
are blank lines upon which a signature can be written.
4. Click Print. After entering any required User IDs and/or Passwords, you see
the Mekorma MICR Check Printing screen.
5. Enter your print settings and click Print when you are ready to print checks.

Printing Check Copies with Checks
Mekorma MICR has a check copy feature that allows you to print a second run of
checks and stubs. The second run prints an exact copy of the stubs and a
modified copy of the check. By default, the check copy prints a gray background
image of the word “VOID” in large letters across the whole face of the check.

NOTE
The Copy Printer automatically prints the check copies according to the Number
of Copies specified.
You can also print check copies automatically to PDF using the Check Copies to
PDF feature. Please see the Printing Check Copies to PDF section that follows
for complete instructions. The option to print check copies is located on the
Mekorma MICR Check Printing screen that displays when you are ready to print
checks. To print copies, check the Use Copy Printer option.
Select the number of copies you want to print. You can also choose to from the
following Copy Options:
Select
Keep Copies Separate to print copies after checks are printed.

27

Keep Copies with Checks to print check copies with the checks.
Select the Copy Stub, Copy Printer and Paper Bin for the check copies using
the drop-down lists. If you are printing Overflow copies, you can also select a
stub format, printer, and paper bin for overflow copies.

NOTE
You can set the Use Copy Printer option to default to the “On” position by
clicking the Keep Print Window Open After Printing checkbox on the Mekorma
MICR System Options screen.

Printing Check Copies to PDF
The check copies to PDF feature automatically generates PDF copies of each
individual check printed and posted. Check copies are stored in a location
defined on the System Options screen.

 IMPORTANT
The automatic PDF copies feature is an optional resource-intensive
feature that can affect performance speed during printing.
After configuring the folder and naming hierarchy of PDF check copies (if
desired) on the System Options screen, when you print and post checks, a copy
of each individual check is automatically generated and placed in the applicable
folder or subfolder. You must post checks before you can generate PDF check
copies.

NOTE
If your checkbook is configured for EFT and you print PDF check copies, the
copies will use EFT numbers for the naming convention instead of check
numbers.
Automatic check copies are generated when you print:
•

Payables Batch Checks

•

Payables Transaction Checks

•

Payroll Checks

•

Canadian Payroll Checks

•

Miscellaneous Checks

NOTE
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If you change the check stub format in the Copy Stub or Copy Overflow Stub
field of the Mekorma MICR Check Printing screen, the new stub format is used to
generate the PDF check copy.
To view the PDFs, after posting, navigate to the folder location defined for the
PDF check copies on the Mekorma MICR System Options screen. Open the PDF
file to view the check copy:
PDF Check Copies follow the standard Mekorma MICR check copy rules and do
NOT display:
•

MICR Line

•

Signatures

•

Signature Lines

NOTE
PDF Check Copies are not supported for Blank Checks or the Test Layout and
Security feature.

Generating Automatic PDF Check
Copies
Open Mekorma Systems Options: Microsoft Dynamics GP  Tools  Setup
 System  Mekorma MICR  System Options.
Mekorma MICR provides the option to email EFTs to vendors in PDF format
and/or to generate automatic PDF copies of posted checks. Both of these options
include the ability to specify the folder location and naming convention of the
PDF.
If either or both Enable PDF Check Copies and Enable Email Remittance
options are selected, all PDFs are generated in the folder location specified in the
Base Folder field. If only Enable Email Remittance is selected, the folder and
file configuration is used to generate a PDF for the email. Please see Emailing
EFT Remittances for information on using this feature.
If Enable PDF Check Copies is unchecked, the EFT PDF is deleted from the
folder after the email is sent to the vendor. If Enable PDF Check Copies is
checked, EFT Remittance PDF remains in the folder location after a copy is
emailed to the vendor.
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You can add subfolders using the options in the Available Fields for Folder
Name section. The PDF is given the file naming convention specified in the
Available Fields for File Name section.
Setting Up Automatic PDF Copies
Click the Enable PDF Check Copies option to enable the automatic Printing
Check Copies to PDF feature. The path defined in the Base Folder field is used
to store the PDFs. If the Base Folder field was populated prior to upgrading, the
Enable PDF Check Copies option is automatically checked.

 IMPORTANT
The folder containing the PDF files should be a shared network
folder that all applicable users have access to.
To define the folder hierarchy, choose from the options listed under the
Available Fields for Folders section. Each folder path you select is created as a
sub-folder under the Base Folder field location. So if you configured the folder
hierarchy as Company ID | Date | Vendor ID on the Mekorma MICR System
Options screen.
To define the naming convention of the PDF, select from the options listed under
the Available Fields for Filename section. The naming convention following the
hierarchy that is defined, so if you configured the hierarchy as Company ID |
Batch Number | Check Number on the Mekorma MICR System Options screen:
You must set a naming convention for the PDFs before you can save your
settings. When you are finished configuring the options on the Mekorma MICR
System Options screen, click Save to close the screen and save your settings.

Using the Check Image Archive
With Check Image Archive, you can view and print an image of the check from
the following Payables, US Payroll and Canadian Payroll screens:
•

Payables Payments Zoom

•

Payroll Check Inquiry

•

Payroll Transaction Inquiry

•

Canadian Payroll Inquiry

•

Miscellaneous Check Inquiry
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 IMPORTANT
This is an optional feature. Please be aware that when using the
Check Image Archive feature, your performance speed when printing
checks will be slower.
The Check Image Archive uses the format specified in the Copy Stub field of the
Mekorma MICR Check Printing screen at the time the check was printed. If no
format was specified in the Copy Stub field, the format in the Check Stub field
will be used.
To view check images, open an Inquiry screen. For this example, we will use
Inquiry  Purchasing  Transaction by Vendor. On the Payables
Transaction Inquiry screen, choose the applicable vendor, highlight the check
number you want to zoom to, and click the Voucher/Payment Number or
Document Number hyperlinks.
If you checked the Auto Show Check Inquiry Preview option on the System
Options screen, the Payables Payment Zoom screen displays with the check
image located to the right.
Payables check images follow the rules of Mekorma MICR check copies and do
not display the MICR Line, Signatures, or Signature Lines. They also contain the
word “VOID”. To print the check image, click Print icon on the toolbar. If security
is set to User ID, you also see the audit information associated with the payment:
If you did not check the Auto Show Check Inquiry Preview option, when the
Payables Payment Zoom screen displays, select Additional  Show Inquiry
Check Preview to display the check image:

 TIP
You can also use the CTRL+M shortcut to display the check image.

For Payroll check image archive, after printing and posting Payroll checks, select
a Payroll Inquiry, for example, Inquiry  Payroll  Check History.
On the Payroll Check Inquiry screen, select an Employee ID. On the detail
screen that displays, highlight a check number. When you highlight the check,
you see the check image archive:
Click the Print icon to print the check image. Payroll check images follow the
rules of Mekorma MICR check copies and do not display the MICR Line,
Signatures, or Signature Lines. They also contain the word “VOID”.

NOTE
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If your checkbook is configured for EFT, the check image archive will use EFT
numbers for the naming convention instead of check numbers.

Auto Show Inquiry Check Preview
If check image archiving is enabled, mark this option to automatically display
check images from the Dynamics GP Inquiry screens. If unmarked, you can use
the CTRL+M shortcut to display the image.

Using the Connector to Multi-Entity
Management*
MEM Connector for Payables
The Mekorma MICR MEM Payables Connector module integrate with Binary
Stream’s Multi-Entity Management® product to provide access to facility
information for vouchers printed on Mekorma MICR check stubs. The MEM
Connector for Payables requires a separate registration key.
*The Connector to Binary Stream’s Multi-Entity Management is a premium
feature of Mekorma MICR. A separate license is required to use this feature.
Depending on which version of Multi-entity Management is set up for your
organization, you will find the facility fields in either the MEM Decentralized
Payables category, or the MEM Centralized Payables category. The following six
new fields are available in the Mekorma Configurator:
•

Facility ID

•

Facility Name

•

Facility Company Name

•

Facility Address

•

Internet User Defined 1 (from the Company Internet Information window)

•

Internet User Defined 2 (from the Company Internet Information window)

An optional check sort by Facility ID or by Facility Name is also available for
Decentralized Payables. For Centralized Payables, you can select a setup
option to sort transactions on the check stub by Facility ID or Facility Name and
print a subtotal at the end of each facility grouping.
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The subtotal line contains the Facility ID and Facility Name in the Transaction
Description column, and the facility total in the New Amount Paid column. All
other fields on the line are left blank. You may also choose an option to print a
Grand Total line after the last subtotal line. The following is an example of how a
check stub will print when using facility subtotals and a grand total:
Example:
Voucher# Description
Amt

Voucher Amt

Disc

Voucher 1 Description for Voucher 1
229.50
Voucher 2 Description for Voucher 2
382.50
123001-Main
612.00

$255.00

25.50

$425.00

42.50

$680.00

68.00

Voucher 3 Description for Voucher 3
250.00
Voucher 4 Description for Voucher 4
125.00
456001-North
375.00

$250.00

0.00

$125.00

0.00

$375.00

0.00

Paid

Check Total
987.00
For correct alignment of columns on the stub when using the subtotal options, all
normal voucher line fields should be replaced with fields from the MEM
Centralized Payables category of the Configurator.
The following fields are provided for placement on the stub layout:
•

Document Number

•

Voucher Number

•

Document Date

•

Voucher Date

•

Transaction Description

•

Purchase Order Number

•

Discount Taken Amount

•

New Amount Paid (TechKnowledge 18381)

•

Document Amount
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•

Facility ID

•

Facility Name

•

Facility Company Name

Setting up the MICR-MEM Connector Options
1. Go to Microsoft Dynamics GP  Tools  Setup  Purchasing  Mekorma
MICR—MEM Integration Setup. You see the Mekorma MICR MEM Integration
Setup screen.
2. Select an option in the first section to define Facility Check Sorting and an option
in the second section to define the Facility Check Stub Subtotal.
3. If you select Subtotal by Facility ID or Subtotal by Facility Name, the Print
Grand Total checkbox displays.
4. Check the Print Grand Total option to include a grand total of all facilities on the
check at the bottom of the stub.
5. Click OK to save your changes or Cancel to exit without making changes.
1. On the Integration Options screen, check the End Payables Document and End
Payables Voucher options.
2. Click OK to close this screen and OK again to close the Mekorma MICR
Integration Setup screen.
3. Click Save on the Mekorma MICR Setup dialog box to finish enabling the
integration for the selected checkbook.
4. Repeat these steps for each checkbook that will be using the Connector.
Sorting by Facility ID
If you would like checks to sort in Facility ID order, mark the Specify Payables
Sort Key option on the Integration Options screen when you check the End
Payables Document and End Payables Voucher options (see Step #6 in the
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prior page). If you prefer to use normal MICR sorting options, leave this checkbox
unmarked.
Using the New Fields
After integrating the Connector with a checkbook, the Facility ID, Facility Name,
Facility Company Name, Facility Address, Internet User Defined 1, and
Internet User Defined 2 fields are available in the MEM Decentralized
Payables and MEM Centralized Payables category of the Mekorma
Configurator for placement on the stub layout.
Facility ID, Facility Name, and Company Name are multi-line fields (to print on
each voucher line) for Centralized Payables and single-line fields (to print in the
header) for Decentralized Payables.
Internet User Defined 1 and Internet User Defined 2 are single-line fields in
both categories. Facility Address is a multi-line field which contains one line
each for address 1, 2, and 3 (if they are populated) and a final line containing
city, state, and zip code. This field is only available for Decentralized Payables.

MEM Connector for US Payroll
When Binary Stream’s Multi-Entity Management is installed, each employee is
assigned to a facility, and each facility is assigned to a payroll checkbook. When
payroll is processed, multiple checkbooks may be accessed.
Check numbers are assigned according to the checkbook associated with the
employee’s facility. This connector adds functionality to Mekorma MICR to
handle the integration with MEM for payroll. The MEM Connector for Payroll
requires separate registration keys.

 IMPORTANT
All payroll checkbooks should be set up with the same stub layout
file. Only one layout is used when printing payroll checks. No
passwords are allowed for payroll checkbooks when MEM is
installed with Mekorma MICR.
The MEM Connector for US Payroll provides the following custom sort order for
payroll checks:
1. Facility ID
2. Division Code
3. Class ID
4. Last Name of Employee
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5. First Name of Employee
The MEM Connector hides payroll hours on the check stub if the pay code for the
employee ends with the letters “SLY”. This requires a custom field for the payroll
hours on the check stub. If you want to use this functionality, the normal “Hours
Array” field on the check stub should be replaced with this field from the Payroll
Custom category:
Payroll Custom::Hours Array
The MEM Connector also adds eight fields to the Mekorma Configurator to allow
users to incorporate fields from Binary Stream’s Multi-Facility Processing into
their payroll check processing.
The following new fields are located in the Check category of the Configurator:
•

Check::Facility Name field – This is the Description field in the GL Segment
Description Setup table where the Segment Number = 1 and the Segment ID is
the Facility ID.

•

Check::Facility Stub String field - This is a concatenated field consisting of the
Facility ID, Division Code (from the Employee Master table), and the Employee
ID. This field is separated by hyphens.

•

Check::Facility Check String field – This is a concatenated field consisting of
the Facility ID, Division Code (from the Employee Master table), Employee ID,
and Employee Class ID. This field is separated by hyphens.

•

Check::Facility Address field – This is a multi-line field that will contain the
street address, city, state, and zip code for the facility.

•

Check::Internet User Defined 1 field—from the Company Internet Information
window

•

Check::Internet User Defined 2 field—from the Company Internet Information
window

The following fields are located in the Logical Fields category of the
Configurator:
•

Logical Fields::Facility Signature 1

•

Logical Fields::Facility Signature 2

These fields are required only if Mekorma MICR security is set to Security by
Checkbook. Please see the Signatures & Passwords by Checkbook section for
more information about facility signatures.

NOTE
You must be logged on as the “sa” user to create the table.
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1. Click anywhere on the Dynamics GP shortcuts bar and select Add  Add
Window. You see the Add Window Shortcut screen.
2. Expand the MEM Connector for Payroll listing and then expand System. Select
MEM Connector for Payroll Table Maintenance.
3. Click Add and then click Done when you are finished to close the Add Window
Shortcut screen.
4. On the shortcut navigation pane, click on the MEM Connector for Payroll Table
Maintenance shortcut you just added.
5. Click Process. A message displays when the table has been created. Click OK
to close the screen.
Setting Up Facility Signature ID's
In normal MICR payroll processing when security is by checkbook, a default
Signature ID is assigned for all payroll checks. With the MEM Connector for
Decentralized Payroll, a Signature ID needs to be defined for each payroll
checkbook. This setup is used to determine which signatures print on the checks
and when the signatures should be printed.
1. Go to Microsoft Dynamics GP  Tools  Setup  Payroll  Mekorma MICR
US Payroll  Facility Signature ID. You see the Mekorma MICR Password
and Signature Setup screen.

2. Enter information to define a Signature ID for each payroll checkbook.

 IMPORTANT
The Signature ID must match the payroll Checkbook ID.
Signature 1 and Signature 2 will print in the Facility Signature 1 and Facility
Signature 2 fields on the check layout. Detailed instructions for defining
Signature ID’s can be found in the Signatures & Passwords by Checkbook
section.
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